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DISCLAIMER
The contents of this manual do not necessarily reflect the official views or policies of the Indiana
Department of Transportation (INDOT). The details in this manual are intended for reference
only, not as specifications or design guidance. In the event that any information presented herein
conflicts with the Indiana Design Manual, INDOT Standard Specifications or other INDOT

policy, said policy will take precedence.
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1 INTRODUCTION

The evaluation software “INDOT WATER STRIPPING SEVEIRTY EVALUATION
(iMoisture)” was developed to aid the water stripping severity evaluation and incorporate
INDOT subsurface condition evaluation process. Asphalt mixture is primarily composed of
asphalt and aggregate. Aggregates should be completely coated by asphalt. Thus, the uncoated
aggregate is an index of water stripping, iMoisture detects uncoated aggregates and quantifies the
area in a sample by employing the digital image analysis technology.
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2 INSTALLLATION GUIDE

2.1 BEFORE INSTALLATION

iMoisture was developed using ADOBE Flex technology and requires ADOBE AIR 3.5 to run
the application. You can download ADOBE AIR 3.5 or newer version from
http://get.adobe.com/air/.

In addition, you need to check that your computer has the following minimum requirements to
run iMoisture:

Windows

e 2.33GHz or faster x86-compatible processor or Intel® Atom™ 1.6GHz or faster
processor for netbooks

e Microsoft® Windows® XP Home, Professional, or Tablet PC Edition with Service Pack
3; Windows Server® 2003; Windows Server® 2008; Windows Vista® Home Premium,
Business, Ultimate, or Enterprise (including 64-bit editions) with Service Pack 2; or

Windows 7
e 512MB of RAM (1GB recommended)
Mac OS

e Intel® Core™ Duo 1.83GHz or faster processor
e Mac OS X v10.6, v10.7, or v10.8
e 512MB of RAM (1GB recommended)


http://get.adobe.com/air/
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2.2 INSTALLING IMOISTURE

To install iMoisture, follow these steps:

1. Download iMoisture installer from https://engineering.purdue.edu/people/hyung.j.ahn.1.
The iMoisture installer icon should appear on your desktop.

(o

e,

Atubs =2 k.

2. Run iMoisture Installer by double-clicking on the iMoisture_Install icon on your desktop.
Click the Yes button to continue. An application install status window should appear
followed by an install completion window.

Entracting files...

t25.dl

Cancel |

@ iMeisture has been successfully installed on your computer.

3. You have finished installing iMoisture and an iMoisture icon shown below should now
appear on your Windows desktop.

IMoisture
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3 OVERVIEW

iMoisture interface consists of four major elements, namely Menu bar (1), Selection
panel (2), General panel (3) and Analysis panel (4).

Al iMoisture |E||E||E|
(1) 4) |

(2)

General

Date 1/21/2013 v (3)

District Crawfordsvile

Subdistrict Cloverdale -

Road Name

Direction MNorth =

R.P. 0 T+ 00 3

Lane Location Passing Lane Left hd

Mid-Layer Depth 0.0 =i

Thickness 0.0 F|in

Mixture Designation |Unknown

Agagregate Type Unkniowni -
Mote
Result
Stripped
Agagregate
Total

3.1 MENU BAR

Application menus are located in the upper left corner of the window and consist of View,
Tool and Help.
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View Tool Help

3.11 VIEW

The figure below illustrates the View menu. This allows a user to switch between different
display mode (i.e., overview, original, coated and uncoated) and displays the keyboard shortcuts
designated for each tab.

View | Tool Help

Fit to Window

Overview
Original
Aggregate
Asphalt

=T = [ *+ [ -]

L L

3.1.2 TOOL

The Tool menu allows a user to run Wizard, print report, and manually adjust the threshold
value for the analysis. The function of Wizard and advanced controller are explained in detail in
Ch. 34.

View | Tool | Help
— Run Wizard
Print Report

Advanced Controller




3.1.3 HELP
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The figure below illustrates the Help menu. This provides the manual and software version

information.

L

Manual

About

View Tool | Help

O

&+

* ]l =]
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3.2 SELECTION PANEL

The Selection panel allows a user to import digital image file(s) to be analyzed and displays
the selected image. It is important that user imports correct digital image at each panel.

oo

: imports digital image file(s)

e | removes the selected digital image from selection tab

. —__: the digital image of broken face after IDT should be loaded here
o = _I: the digital image of cut face should loaded here
iMoisture |E||E||E|
o snGowers S -

Date 1/21/2013 v

District Crawfordsvile ~

Subdistrict Cloverdale -

Road Name

Direction North -

R.P a = +| 00

Lane Location Passing Lane Left A4

Mid-Layer Depth 0.0 = in.

Thickness 0.0 [Fin

Mixture Designation |Unknown -
Aggregate Type Unkniown -

Note

Result
Stripped

Aggregate

Total
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3.3 GENERAL PANEL

The General panel allows a user to input general information regarding specimen and location
along with mixture and aggregate type. The District and Sub-district features are Indiana’s, and
mixture designation is based on the Indiana Design Manual Chapter 52 (1). In addition, the
analysis results are displayed at the bottom.

Al iMoisture o || =] ER
EEmTemmmmmme e s BB 1
1 1
1 Date 1/21/2013 w 1
: District Crawfordsvile - :
I Subdistrict Cloverdale - 1
1 1
e R
: Direction :
| we o e B
1 1
1 Lane Location Paszsing Lane Left - 1
: Mid-Layer Depth in. :
| Thickness ir|. 1
1
| Wocure Designation ]
L somreasc e :
1 nNote 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
] Result 1
1 oed 1
1 Strippe: 1
1 1
1 Agagregate 1
1 1
1 Total 1
1 1
__________________
[ 1




3.4 ANALYSIS PANEL
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The Analysis panel presents analyzed digital images by the selected display mode and

instantly updates as any changes occurs in selected values. It also features a Wizard option
button in the left upper corner of the window, which allows a user to select the different
threshold value. Finally, iMoisture allows a user manually control threshold value as an

Advanced Control option.

A

iMoisture ===

-

General

Date

District
Subdistrict
Road Name
Direction

R.P.

Lane Location
Mid-Layer Depth
Thickness

Aggregate Type

Note

Result

1/21/2013 v
Crawfordsvile

Cloverdale v

North v

0 S| +00

Passing Lane Left

0.0 [3]in.
< |in.

0.0

Mixture Designation 'Unknown v

Unknown

Stripped 64.97 %

Agaregate 53.22 %

Total

4

Wizard || Overview

Original Aggregate Asphalt
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3.4.1 DISPLAY MODE

There are four different display modes are available, namely overview, original, coated and
uncoated.

Overview: displays coated and uncoated area in different colors over the original digital
image

Original: unprocessed original digital image is displayed
e g: " ;. L W L Eiag ;

strippe) portion of the original iage ae displayed
ol e N PR R
k.3

10
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34.2 WIZARD

The Wizard option allows a user to select different threshold value to be used in the analysis.
When a user clicks the wizard option, a new window is generated containing four different
images processed with different threshold value. A user then can select the one separates the
coated and uncoated portion best.

ol iMoisture Wizard ;

Pick your best option below...
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3.43 ADVANCED CONTROL

The Advanced Control option allows a user to manually adjust threshold value to be used

in the analysis. The option can be accessed through Tool in menu bar. When a user clicks the
option, a new control bar is generated containing threshold value, which ranges from 0 to 100. A
user then can select the best threshold value that separates the coated and uncoated portion most
accurately.

A iMoisture ===

Wizard | Overview Original Asphalt

- - - -
__________________ -

| Advanced Controller 1
1 B = 1
. i @B
e

General

Date 1/21/2013 v

District Crawfordsvile v

Subdistrict [Cloverdale v

Road Name

Direction North v

R.P. 0 1| +|00 =

Lane Location \passinglaneleft v

Mid-Layer Depth 0.0 |3

Thickness 0.0 |5

Mixture Designation |Unknown ¥
Aggregate Type Unknown v

Note

Result
Stripped 64.97 %

Aggregate 53.22 %

Total

12
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4 GETTING STARTED

4.1 LAUNCHING iMoisture

Run iMoisture by double-clicking on the iMoisture icon on your desktop or

IMoisture

in your Windows Start menu.

13
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HOW TO TAKE DIGITAL IMAGE

Digital image is a vital part of iMoisture. The information below provides important
requirements on how to take digital image to obtain the best result.

Sufficient lighting should be provided when image is taken as iMoisture detects
differences in reflection from different materials. In addition, it is imperative to have
uniform brightness in digital images taken. However, it is difficult control lighting
condition especially in the field. Use of light meter, which measures the amount of light,
provides constant which is then used to determine the proper exposure for digital image.
Consequently, digital image as if taken under uniform lighting condition can be obtained
by adjusting digital camera settings based on the reading from the light meter.

For digital camera positioning, Image should be taken while you set up or hold the digital
camera perpendicular to the flat surface of the specimen. Example digital camera setup
with the tripod is shown below.

14
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4.3 HOW TO PREPARE DITIAL IMAGE

Image to be used with iMoisture should not contain any background or specimen edges. Edges
can be negatively affect the analysis result as it is considered as uncoated material while they are
simply displaying cut surfaces caused by coring process. Finally, either side of two split surfaces
may be used. Crop the image so if it does not match the requirement, as shown below.

Incorrect Correct

In order to crop picture, a user can choose any available software and there are many free open
source software available (e.g., Gimp, Irfanview, and Paint.Net). Software available to all
computers with Microsoft Office 2007 or newer version is Microsoft Office Picture Manager;
thus, step by step procedure on cropping image is illustrated below using Microsoft Office
Picture Manager (Name changes to Microsoft Office 2010 in Microsoft Office 2010).

To start editing the image, right-click on any photo and select Open With, from the list select
Windows Office Picture Manager, if it is not given in the list, click on Choose Default
Program. Now click on Other Programs and you will find it there.

15
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| [ New item ~ Y [Elopen~ HH selectan
u Edit 29 Select none
I& History 55 Invert selection

\ —‘ﬂEasyactess -
New Properties
folder ¥

New Open Select

Layer » WHTIE » Original » 1

Preview
Edit
Edit with GIMP

& Set as desktop background
1R3F_B_DEM(C Print
HED

Preview
Rotate right
Rotate left
7-Zip >
[&f  Edit with Notepad++
| Openwith »| % IrfanView
Add to a Photo Stream » | @l Paint
Share with > PelnLNEL
[a] Photos
W Scanforthreats... [ PictureViewer
Send to » B  Windows Live Movie Maker
Cut ® Windows Live Photo Gallery
Copy r [ PHOTER e mmm g
x| Microsoft Office 2010
Create shortcut _|c — tce_ ———— ‘l
Delete Choose default program...
Rename

Open file location

Properties

Once you have opened the image with Microsoft Office Picture Manager, click on Edit
Pictures.

=] Nicroson Office 2010 =@ s
: —-— -

Ble Edt View Pictre Iook Help Type a guestion foc idp =
glshotcus.. i ED 6 kG L X 0 oy -a__,s‘;.l (i EditPictures.. 5] Auto Comect
| ERE

R1B Gt oo c)

16
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Edit Pictures toolbox will appear on the right side, now under Edit using these tools, click
on Crop, and you will see multiple options.

* Edit Pictures w x - —
L :Lrop
9 @ o _
@ @ @
1 files selected
Correct pictures automatically 1 files selected
Crop settings

To automatically correct color and

brightness for the selected Aspect ratio:

pictures, dick Auto Correct,
®) Landscape
Auto Correct Fortrait

Edit using these tools Crop handles

|E Erightness and Contrast Left: pixels

& color Right: pixels
_—— = =
L-|'a" Crop 3 Top: pixels

@;.— Rotate and Flip Bt pixels

4T

Red Eye Removal Picture dimensions

Change picture size Original: 2659 x 2659 pixels

‘:& Resize Mew: 2659 x 2659 pixels

E Compress Pictures 0K

After adjusting the size, click OK.

El Microsoft Office 2010 = [@ =]
Ble Edt View Pictre Tooks Help T 3
g W 83 4D AX 90 B Q18 5% Peareue. Hawecons

Zaa e =

oy Q9 &
L .|
e ) G| @ v et

17



Indiana Seal Coat Design Software Guide

4.4 DIGITAL IMAGE REQUIREMENT

iMoisture requires two different images to be loaded for the water stripping severity analysis.
The first image is from cut face of specimen prior to IDT test and used for calculating the area
covered with aggregate. The other image is from broken face of specimen after IDT test and used
for quantifying the stripped aggregate area. The examples of each type of images are shown
below. It is important that correct image type should be loaded into the right selection panel.

45 ANALYSIS EXAMPLE

The following example illustrates how to evaluate water stripping severity using iMoisture step
by step. Procedures presented in this example are designed to help the first-time user to become
more familiar with iMoisture, but hereafter a user may enter and edit values for each required
input in any order.

18
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451 STEP1

A user can attach any type of image file with no size limit. The figure below illustrates how to
add or delete image files.

To add image files, follow these steps:

1. Click the|'”‘ | button.

0
[

Al iMoisture

‘v\ﬁzard ‘ Overview 7‘[ Original J Aggregate ‘ Asphalt

+ 2= |

EEEEEEEa?
Advanced Controller

General
Date 1/21/2013 v |
District Crawfordsvile v
Subdistrict [Cloverdale |
Road Name
Direction
R.P.

Lane Location

Mid-Layer Depth

Thickness

Mixture Designation | Unknown "

Aggregate Type ﬁr}known %]
Note
Result

Stripped 36.66 %

Aggregate 53.22 %

Total

19
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2. Select an image file and then click Open. It should be noted that a user can also use
drag and drop to add an image file.

n] select image file(s). =]
I:(__-) - 1 . v Libraries » Pictures » SPR3507 » Corelayer » GREEN » Cut » 1 v & Search 1 2
Organize = MNew folder =~ [ @
A
W Favorites
B Desktop
&4 Downloads
% Dropbox

|# Photo Stream

= Recent places

4 Libraries
@ Documents

J’ Music

(&= Pictures

B Videos

% Homegroup
&\ Hyung-Jun Ahn
v

Bl

File name: | 1R1 w | u ol fribes @i m b

Open Cancel

"
4EEEEEEEERSD

20
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To delete files, click the image, then click the | - | button
iMoisture [EE]=]

!VWzardH Overview ” Original H Aggregate “ Asphalt l

General

pae (vziss ]
District |crawfordsvile ~ |
Subdistrict [Cloverdale  ~|
Direction @

Lane Location m& v
Mid-ayer Depth  |0.0
Thickness 00 tfin.
Mixture Designation |Unknown v |
Aggregate Type (Unkmwn—
Note

4

L

Result
Stripped 36.66 %

Aggregate 53.22 %

Total

21
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452 STEP2

Enter location information, including lane location and layer depth, which is the depth measured
from the midpoint of the layer to the surface. For district selection, a user can choose from one of
six districts of Indiana. Once a district is selected, a list of subdistricts corresponding to the
selected district becomes available.

Al iMoisture (=@ =]

vWizard Overview ' Original ‘ Aggregate Asphalt

L

Advanced Controller

Thickness 0.0 t=lin.

Mixture Designation |DG 12.5 v |

55 [2]
“‘I'""""""""""""'T.

o General %
0 £ . s
x Date 1/21/2013 v | .
.
= District Vincennes v .
. e ———— =
®  Subdistrict Tell Gity. v | E
L]

" RoadName \SR-70 .
= Direction East ¥ .
— L]
| PO =
= | RP 3 El+loa E .
" e = =l :
. Lane Location Passing Lane Right v u
. ——— = n
. Mid-Layer Depth o
= =
- -
: :
- -
- -
: :
- -
- -
L]
. .
k. R
L4

Aggregate Type [ Lln¥stnne v
Note
.
., 0
“ssssssssssssssssnsannnnnnns®
Result

Stripped 52.29 %

Aggregate 53.22 %

Total

22
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453 STEP3

Water stripping severity is automatically generated once the image file is loaded and selected
from Selection panel. Review the processed images and use Wizard or Advanced
Control option should a user need to make changes (Section 3.4.2 and 3.4.3).

Al iMoisture [S]@] =]

anzard Overview ‘ Original ‘ Aggregate Asphalt

Advanced Controller

General

Date 1/21/2013  v|
District ’\hnéenrﬁre's -
Subdistrict Tell Gity v

Road Name |SR-70

Direction 'East v

s El+e B
Lane Location Pa:&;g LE ng;'ltiv
Mid-Layer Depth I B

Thickness

Mixture Designation DG 12.5 ;‘
Aggregate Type [ Llrgshone Vi ‘
Note

Result

Stripped 52.29 %

Aggregate 53.22 %

Total

23
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454 STEP4

The last step is to save your work. You can save your work at anytime by typing the keyboard
shortcut CTRL + S.

To save your work, follow these steps:

1. Click the File button.

Mew Ctrl+M
Open Ctrl+0
Save Ctrl+5
Save As Ctrl+ 4
Close Ctrl+W
Exit Ctrl+Q

2. Click either the Save or the Save As.

(File| view Help
Mew Ctrl+M
Open Ctrl+0O
P Save : CtrleS
Psavepst oA
Close Ctrl+W
Exit Ctrl+Q

24
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